TACTICAL FLIGHT MISSION PLANNING AND MAP PREPARATION GUIDE

References
TC 1-237 (October 2007), FM 3-04.203 (May 2007)
FM 4-20.197 (20 July 2006), TC 1-400 (April 2006)
FM 101-5 (31 May 1997), FM 90-4 (March 1987)

7 December 2009

DISTRIBUTION RESTRICTION:
Approved for public release; distribution is unlimited. This publication supersedes all previous versions.
PURPOSE

The purpose of this document is to consolidate and couple multiple doctrinal references with established and commonly accepted planning techniques and procedures. It is intended for student use in training, standardizing map preparation and mission planning considerations and to provide focus on critical elements of mission tasks. It is not intended to replace or supersede Training Circulars, Field Manuals or serve as a reference for student daily questions.

APPROVAL:

MICHAEL F. BURNS III, COMMANDER, 1-212TH AVIATION REGIMENT
Table of Contents

Major learning objectives ........................................................................................................................................ 4
How the unit receives a mission ......................................................................................................................... 6
Planning considerations ........................................................................................................................................ 7
Analyze the mission (METT-TC) ....................................................................................................................... 7
Perform map/photo reconnaissance .................................................................................................................. 8
Select the appropriate altitude(s) and terrain flight modes ............................................................................. 8
Select appropriate primary and alternate routes ............................................................................................... 9
Determine the distance, ground speed and time en route for each leg of flight .............................................. 10
Determine the fuel required ............................................................................................................................. 10
Obtain and analyze weather briefing ............................................................................................................... 10
Conduct a thorough crew mission briefing .................................................................................................... 10
Additional considerations for tactical and terrain flight .................................................................................. 11
Terrain flight performance ............................................................................................................................... 11
Terrain flight safety ........................................................................................................................................... 11
Aircraft survivability equipment ..................................................................................................................... 11
Perform actions on contact .............................................................................................................................. 12
  ANNEX A Example Air Mission Briefing / Operations Order ....................................................................... 13
  ANNEX B Tactical Flight Mission Planning .................................................................................................. 16
  ANNEX C Map Preparation ........................................................................................................................... 21
  ANNEX D Map Symbology ............................................................................................................................ 22
  ANNEX E Tactical Mission Kneeboard Packet .............................................................................................. 29
  ANNEX F Multi-Aircraft Operations ............................................................................................................ 34
  ANNEX G Sling Load Operations .................................................................................................................. 41
  ANNEX H Hand and Arm Signals .................................................................................................................. 45
  ANNEX I Combat Flight Planning System (CFPS) and Falcon View .......................................................... 51
MAJOR LEARNING OBJECTIVES

Major Learning Objectives: Pilots are to be familiar with the objectives listed below; be capable of discussing and applying these concepts during mission planning in accordance with TC 1-237, FM 1-400, FM 3-04.203, FM 4-20.197 and FM 90-4.

1. How the unit receives a mission. (FM 90-4 and FM 3-04.203)
   a. Warning Order (WARNO).
   b. Operations Order (OPORD).
   c. Fragmentary Order (FRAGO)

2. The five paragraphs of an Operations Order. (FM 90-4 and FM 3-04.203)
   a. Situation
   b. Mission.
   c. Execution.
   d. Service and Support.
   e. Command and Signal.


4. Additional Considerations for Tactical and Terrain Flight
   a. Terrain Flight Performance. (TC 1-237, and FM 3-04.203 Chapter 5)
      (1) Proper Crew Mix / Crew Integration.
      (2) Air Crewmember duties and crew coordination.
      (3) NOE and contour navigation instructions.
   b. Terrain Flight Safety – Hazards to Terrain Flight. (FM 3-04.203 Chapter 5)
      (1) Physical Hazards—Manmade and Natural
      (2) Weather Hazards—Restricted Visibility and Wind Conditions
      (3) Human Factors—Fatigue and Obstacle Detection Ability
      (1) AN /APR 39 A (V) 1.
      (2) M-130.
      (3) AN /ALQ 144A (V) 1.
      (4) Mark XII IFF System.

5. Perform actions on contact. (TC 1-237 Task 2042)

   a. Composition and size of flight formations.
   b. Horizontal Distance.
   c. Vertical Separation.
   d. Types of Formations: Advantages and Disadvantages.
   e. Techniques for initiating formation changes while in flight: Light signals, radio calls, designation of points on the ground.
   f. Formation flight techniques during take-off, enroute, approach, and landing.
   g. Inadvertent Instrument Meteorological Conditions Breakup Plan.
   h. Landing environment: Dust, Snow, Sloping, loss of visual contact, etc.
7. Perform Sling Load Operations. (TC 1-237 Task 2048, FM 90-4 Chapter 6, FM 3-04.203 Chapter 2, FM 4-20.197 Appendix A)
   a. Load categories: High density, low density and aerodynamic.
   b. Situations that favor sling loads.
   c. Basic sling load procedures.
   d. Hand and arm signals.
   e. Emergency actions during hook-up/in-flight load oscillations.
   f. Sling Load site set-up.
   g. Performance Planning Considerations.


HOW THE UNIT RECEIVES A MISSION

1. Training to standard and proficiency in performing Tactical Flight Mission Planning is essential to all Air Assault operations. Missions are often assigned on short notice and there is no time for on-the-job training. The Battalion Operations Officer (S3) typically disseminates the mission to the company level.

2. The mission will be received in the form of an oral or a written Operations Order (OPORD) or Fragmentary Order (FRAGO). A Warning Order (WARNO) typically precedes the OPORD so the supporting unit can prepare for the impending operation.
   
a. Warning Order (WARNO) - - Is a preliminary notice of an order that is to follow. The WARNO helps subordinate units prepare for the impending operation. It maximizes subordinates' planning time by providing details and major time-line events of the mission. Once the mission has been received, a WARNO should be issued by the Air Mission Commander (AMC) to the aircraft crews and maintenance personnel. The WARNO identifies the following:
      
      (1) What the mission is.
      (2) When it will take place.
      (3) Crew and aircraft assignment.
      (4) What preparations to make.
      (5) Time schedule to follow.
      (6) Individual tasking or responsibilities (See Annex A).
   
b. Operations Order (OPORD) - - Possibly an oral order followed by a written order of instructions that defines specific responsibilities for a military operation. The order format is divided into five paragraphs these are directives a commander issues to subordinate commanders to coordinate the execution of an operation. They always specify an execution time and date (See Annex A).

   EXAMPLE FORMAT OF FRAGO / OPORD
   
   1. Situation
   2. Mission
   3. Execution
   4. Service and Support
   5. Command and Signal

   c. Fragmentary Order (FRAGO) - - Provides timely changes of existing orders to subordinate and supporting commanders while providing notification to higher and adjacent commands. A FRAGO is either oral or written and addresses only those parts of the original OPORD that have changed. The sequence of the OPORD is used and all five-paragraph headings must be addressed. After each heading, state either “No Change” or the new information.
PLANNING CONSIDERATIONS

The planning considerations listed and discussed below will enable you to Perform Tactical Flight Mission Planning (Task 2012), meet the task standards and be successful in executing the mission.

1. **Analyze the mission using the mission, enemy, terrain and weather, troops and support available, time available and civil considerations (METT-TC) factors available.**

   a. **Mission** - - The AMC will ensure that he has a clear and concise statement of the mission. The mission involves the critical tasks that must be performed. These are either specific tasks stated by the orders or implied tasks that the commander must deduce. Mission analysis determines the What, Why, When, Where and the How of the operation.

   b. **Enemy** - - The AMC will be given an intelligence summary (INTSUM) that will explain the current enemy situation. General factors to consider are:
      
      (1) Identification.
      (2) Location.
      (3) Disposition.
      (4) Strength.
      (5) Morale.
      (6) Capabilities.
      (7) Composition.
      (8) Probable courses of actions.

   c. **Terrain and Weather** - - General factors to consider are:
      
      (1) Dominant terrain.
      (2) Natural features.
      (3) Possible enemy attack points.
      (4) Built up areas.
      (5) Important crossroads.
      (6) Hazards to flight.
      (7) Friendly units.
      (8) Enemy units.
      (9) Weather and Visibility. Analyze the weather information for trends. If the operation begins in marginal weather, the AMC must consider the possibility that the weather may deteriorate below acceptable limits and adversely affect the mission. Considerations include:

      (a) Fog, low clouds, heavy rain, and other factors that limit visibility for aviators.
      (b) Illumination and moon angle during night vision goggle (NVG) operations.
      (c) Ice, sleet, and freezing rain that degrades aerodynamic efficiency.
      (d) High density altitudes which degrade aircraft engine performance and lift capability.
      (e) Darkness, normally an advantage to well-trained aviators and soldiers.
      (f) High winds (large gust spreads)
      (g) Blowing dust, sand, or snow on pick-up zones (PZs) and/or landing zones (LZs).

   d. **Troops and Support available** - - The AMC will be provided an OPORD from the Air Assault Task Force Commander (AATFC) with the mission of the supported unit and other units that may have an impact on the mission. The AMC must fully understand the intent of the ground commander.
e. Time available - - The AMC will develop a time table for the mission utilizing a reverse planning sequence. This sequence will include post mission accountability checks, refueling, maintenance, mission time (H Hour), and the premission planning phase to the present time. Planning for air assault (AASLT) operations is as detailed as time permits and should include completing written orders and plans as described in chapter 10, TC 1-400. Within time constraints, the AATFC must evaluate capabilities and limitations of the total force and develop a plan that ensures the highest probability of success. The planning time should conform to the “one-third/two-third rule” to ensure subordinates have enough time to plan and rehearse. (See FM 90-4 and FM 3-04.113 for more details.)

f. Civil considerations - - The selection of a particular route and mode of flight must consider the safety of, and potential threat from, any civilian sector.

2. Perform a map/photo reconnaissance using the available map media or photos. Ensure that all known hazards to terrain flight are plotted or entered into the approved mission planning software (if applicable). The type of mission will determine the altitude to be flown based on the threat, terrain, weather, time and safety. Terrain flying includes tactical applications of low level, contour, and nap of the earth (NOE) flight techniques to diminish the enemy’s ability to acquire, track, and engage the aircraft. The following factors should be considered during the map reconnaissance: the dominant terrain, natural features, possible enemy attack points, built up areas, crossroads, main supply routes, hazards to flight, friendly and enemy units (See Annex B).

3. Select the appropriate altitude(s) and terrain flight modes as appropriate. The highest terrain flight altitude for the specific condition should always be used. Flight at higher terrain altitudes reduces the difficulty of navigation, enables higher airspeeds, reduces hazards to terrain flight, and minimizes fatigue.

   a. Terrain Flight Modes - - Terrain flight modes include low-level, contour, and NOE. Selecting an appropriate terrain flight mode can diminish the enemy’s capability to acquire, track, and engage aircraft. Terrain flight is considered sustained flight below 200 feet AGL except during takeoff and landing. Terrain flight requires aircrew proficiency in map reading, preparation, and terrain interpretation. It also requires constant vigilance in identifying terrain features and hazards, and understanding effects of surrounding terrain, ambient light, and seasonal changes in vegetation. Continuous NOE or contour flight is unusual as terrain and vegetation vary. Normally, there is a transition from one mode to the other as the situation dictates. Modes of terrain flight are defined below.
(1) Nap-Of-The-Earth Flight - - NOE flight is conducted at varying airspeeds as close to the earth’s surface as vegetation and obstacles permit up to 25 feet above trees and vegetation in the flight path. Aviators should decrease airspeed if weather and/or ambient light restrict visibility.

(2) Contour Flight - - Contour flight is conducted at low altitudes conforming to the earth’s contours. It is characterized by relatively constant airspeeds and varying altitude as dictated by terrain and obstacles. Contour flight is further defined as operating with the skids or wheels between 25 and 80 feet above highest obstacle (AHO). Aviators should decrease airspeed if weather and/or ambient light restrict visibility.

(3) Low-Level Flight - - Aviators perform low-level flight at constant altitude and airspeed, dictated by threat avoidance. Low-level flight is further defined as operating with the skids or wheels between 80 and 200 feet AHO at airspeeds commensurate with operational requirements and aircrew limitations. Aviators should decrease airspeed if weather and/or ambient light restrict visibility.

b. Techniques of Movement - - Multi-aircraft operations in a high-threat environment may require greater flexibility than is possible with basic flight formations. The flexibility required to conduct multi-aircraft operations at lower terrain flight altitudes is best achieved by employing maneuvering formations in conjunction with techniques of movement. The three methods of movement used when conducting multi-aircraft operations are traveling, traveling overwatch, and bounding overwatch.

(1) Traveling - - Traveling is used to move rapidly over the battlefield when enemy contact is unlikely, or the situation requires speed for evading the enemy. All aircraft move at the same speed. This technique is the fastest method for aircraft formation movement but provides the least amount of security. Units often employ low-level and contour flight at high airspeeds using the traveling movement technique.

(2) Traveling Overwatch - - Traveling overwatch is used when speed is essential and enemy contact is possible. This technique is normally associated with reconnaissance, security, and attack missions when threat and/or environmental conditions preclude use of bounding overwatch. Lead aircraft or teams move constantly, and trail aircraft or teams move as necessary maintaining overwatch of lead.

(3) Bounding Overwatch - - Bounding overwatch is used when enemy contact is expected and the greatest degree of concealment is required. It is the slowest movement technique; too slow for high-tempo operations and too vulnerable for non-linear and/or urban operations. Individual aircraft or aircraft teams employ alternate or successive bounds.

4. Select appropriate primary and alternate routes and enter all of them on a map, route sketch, or into the approved mission planning software. After appropriate terrain flight modes have been selected, primary and alternate routes must be constructed to support these modes. Specific items are inherent to the route structure (See Annex C).

a. Designation of Start Point (SP) and Release Point (RP) - - The first step is to identify tentative SPs and RPs. The distance from the RP to the LZ should allow the flight leader to reconfigure the formation and execute a tactical formation landing.

b. Air Control Point (ACP) - - An easily identifiable point on the terrain or an electronic NAVAID used to provide necessary control during air movement. ACPs are generally designated at each point where the flight route or air corridor makes a definite change in any direction and at any other point deemed necessary for timing or control of the operation. ACPs should be progressively closer as an aircraft nears the objective, facilitating timing and navigation. Type of terrain, illumination, total route distance, and accuracy of onboard navigation systems may allow selection of ACPs much further apart.
c. Communication Checkpoint (CCP) - - An ACP may be further designated as a CCP. A CCP is a point along the flight route where serial commanders report to the AMC. Radio transmissions are made only when necessary using brevity and/or code words.

d. Check Point (CP) - - A CP is a predetermined point on the ground used to control movement, tactical maneuver, and maintain orientation. (DOD, NATO) A CP may be used as a means of controlling aircraft in flight, registration target for fire adjustment, reference for location, or geographical location above which an aircraft in flight may determine its position.

e. Rally Points (ground or aerial) - - Points that are used and selected by the AMC between the SP and RP as a point at which the flight can safely reassemble and reorganize if they become dispersed. Also, Rally Points can be used as a downed aircrew pick-up point

f. Downed Aircrew Pick-up Points - - Points plotted along the primary and alternate routes that should be identifiable from the air and ground, and should be established on the mission route, in or near hostile territory. Pick up times will normally be given in the unit’s Tactical SOP. Crew members should reference Combat Search and Rescue (CSAR) / Special Instructions (SPINS) publications.

g. Distance Tick-Marks - - Marks drawn to bisect the course at desired distance intervals.

h. Time Hack Marks - - Will be plotted along the route in order to insure objectives are met on time. An additional 30 seconds should be added for a formation takeoff from the PZ to the first checkpoint and landing from the release point to the final objective to compensate for acceleration and deceleration. Time calculations can be determined by using the CPU-26A/B flight computer, time tick-mark card, or AMPS computer program.

i. Preplanned Artillery and Tactical Air Forces (TACAIR) - - Preplanned possible enemy target locations must be annotated on your map.

5. **Determine the distance ±1 kilometer, ground speed ±5 knots, and estimated time en route (ETE) ±1 minute for each leg of the flight.** This is a very critical phase of tactical flight mission planning. Accuracy cannot be overstated because this information determines your precision and professionalism as an aviator, and ultimately the reputation of your unit.

6. **Determine the fuel required and reserve per AR 95-1 ±100 pounds.** Fuel may be the only variable you have in planning for your power management, i.e. Max Allowable Gross Weight. The cargo and/or passengers may not be negotiable; therefore planning your mission may require a stop through the Forward Arming and Refueling Point (FARP). When conducting multiaircraft operations, always consider the weakest aircraft performance when determining fuel required for the mission.

7. **Obtain and analyze weather briefing to determine that weather and environmental conditions are adequate to complete the mission.** Obtain a thorough weather briefing which covers the entire mission. This should include solar and lunar data, density altitudes, temperatures, wind, and visibility restrictions. Aircrews should pay particular attention to the ceilings which are normally reported in AGL. An increase in terrain altitude changes may place the aircraft close to or in the clouds.

8. **Conduct a thorough crew mission briefing.** After all premission planning and final coordination has been accomplished, prepare a crew mission briefing. The briefing will utilize the five paragraph OPORD format. All aspects of the mission will be briefed in detail with special attention focusing on actions on the objective. This does not imply that any other portion of planning requires less detail, only that the Ground Force Commander’s intent must be fully understood and executed to accomplish the mission successfully.
1. **Terrain Flight Performance**
   a. The Commander or Platoon Leader is responsible for the crew mix and the Instructor Pilot is responsible for the training of the crews. The Commander will assess the strengths and weaknesses of these crews along with the difficulty of the mission when assigning the crews to the mission. It may be easy to stack the crews with experience, but the unit suffers by not growing junior pilots into experienced crewmembers.
   
b. It is every pilot’s responsibility to be proficient in Aircrew Coordination. The demands of terrain flight complicate each crewmember’s responsibilities which further exemplifies the need for clear and concise communication. Good cockpit management skills are key to success in any mode of flight, but are completely essential in terrain flight.
   
c. Navigation at terrain flight altitudes is demanding. Rally terms are used to facilitate quick and meaningful navigation instructions for the pilot on the controls. The navigating pilot must announce upcoming hazards along the route of flight, ACPs, turns, acceleration/deceleration points, and any other information that requires reaction from the flying pilot. Advance notice of the upcoming event is required so that proper aircraft maneuvering can be accomplished.

2. **Terrain Flight Safety**
   a. Physical hazards are either man-made or natural. Man-made hazards must be annotated to the map and should be analyzed as possible obstructions to the route of flight. Hazards not on the route must also be annotated in the event of deviations from the route. Natural hazards such as trees, birds, and light sources are not possible to annotate and can pose significant problems at terrain flight. Proper scanning techniques are usually sufficient to prevent bird and tree strikes at terrain flight altitudes. Helmet visors should be worn in the down position to aid in prevention of eye damage in the event of tree or bird strikes.
   
b. Weather hazards such as reduced visibility and/or high winds can occur at any time and may make aircraft control difficult or impossible. Contingency planning for such events should be discussed at the Aircrew Mission Brief. GPS and instrument flight proficiency is the pilot’s responsibility and will prove lifesaving when weather hazards pop-up during the execution of the mission.
   
c. Human factors, as hazards, manifest themselves through fatigue and the inability to detect obstacles often resulting with controlled-flight-into-terrain. Detecting fatigue in the crew is not easy, but is usually evident when a crewmember’s performance and reaction time are degraded from their norm. Obstacle avoidance requires diligent scanning; fatigue diminishes this scan and jeopardizes the entire crew. All pilots have different skill levels. Over flying one’s ability, especially at terrain flight, may prove detrimental. Maintain your physical health and never over fly your capability.

3. **Aircraft Survivability Equipment**
   a. The AN/APR-39A(V)1 is a RADAR signal detection set that receives C-D and H-M radio frequency bands, processes the data against programmed electronic warfare data, and displays pulse-type signals on the cathode ray tube (CRT) in the cockpit. When a match of the electronic warfare data occurs, the processor generates the appropriate threat symbology on the CRT and synthetic audio the headset.
   
b. The general purpose dispenser M-130 is primarily utilized as a Chaff Dispenser. The system provides effective survival countermeasures against RADAR-guided weapons systems threats.
   
c. The ALQ-144A(V)1 is an Infrared Counter Measure System. The system transmits IR radiation modulated mechanically at high and low frequencies using an electrically heated source.
d. The Identify Friend or Foe (IFF) is a function of the Transponder Mode 4. The operation is classified.

e. Passive design characteristics/equipment.
   a. Hover Infrared Suppressive System (HIRSS) provides a signature reduction passive countermeasure.
   b. Flat plate glass and low infrared reflective paint together provide a lower IR aircraft signature.

PERFORM ACTIONS ON CONTACT

1. The primary mission may be Air Assault, but an additional task is collection of intelligence on the battlefield. Deploy to cover and concealment by suppressive fire if necessary, and develop the situation.

2. The mission statement may range from “by-pass all elements” to “when encountering platoon sized elements, deploy to cover and report.” If appropriate, obtain detailed intelligence so that the Intelligence Officer (S2) will be able to assess the data and surmise the enemy intent.

3. Transmission of the Tactical Report will be in accordance with the current Standard Operating Procedures (SOP) of the unit. The acronym SALTW is a typical format for the tactical report. S is for the size of the element being observed, A is for the activity, L is for the location (preferably a grid or reference from a known point), T is for the time of observation and W is for what your follow-on actions will be.
ANNEX A

Example Air Mission Briefing / Operations Order

Review FM 90-4, FM 1-400 and Local Regulations for further guidance.

1. Roll Call
2. Packet Inventory
3. SITUATION - A declarative statement.
   a. **Enemy Forces** - Troop concentrations and locations and types of ADA assets.
   b. **Friendly Forces** - Location, strength and readiness.
   c. **Weather** - Ceiling, visibility, wind, temperature, pressure and density altitude, sunrise and sunset, moonrise and moonset, percent of moon illumination, end evening nautical twilight, beginning morning nautical twilight, PZ and LZ altitudes, and weather outlook. At a minimum the current DD Form 175-1 will be briefed and the forecast of the weather throughout the mission.

4. MISSION - The mission will be a clear and concise statement of the task that is to be accomplished (who, what, and when, and, as appropriate, why and where) provided by the S-3, the Company Commander, Company Operations, or other appropriate personnel.

5. EXECUTION - Concept of the operations and the unit supported (mission). Must provide information about WHO, WHAT, WHERE, WHEN and HOW the mission is to be performed. This portion is very detailed and covers every aspect of the mission.
   a. **Ground Tactical Plan** - For an air assault operation it contains essentially the same elements as any other infantry attack, but differs in that it is prepared to capitalize on speed and mobility in order to achieve surprise. Assault echelons are placed on or near the objective and organized so as to be capable of immediate seizure of objective and rapid consolidation for subsequent operations.
   b. **Fire Support Plan** - Addresses how fire support is to be used to support maneuver forces.
   c. **ADA Plan** - Protection for the Air Assault Task Force (AATF), (within friendly lines) is provided by Tactical Air Forces (TACAIR) and all elements of the Air Defense Artillery (ADA) systems (Patriot, Stinger, etc.). When the AATF penetrates enemy held territory, air defense comes from ADA assets that can be displaced by helicopter. Due to weight restriction, the CH-47 is the primary mover of ADA assets such as the Avenger. Priorities for air defense within the AATF are established by the AATFC.
   d. **Engineer Support Plan** - The AATFC, S-3, and the engineer work together to plan the use of engineer assets and establish priorities. The engineer then advises the commander on how to utilize assets based on time, personnel, equipment, and munitions available.
   e. **TACAIR Support Plan** - The U.S. Air Force support for the AATF normally includes tactical air reconnaissance, close air support, and tactical airlift. The AATF staff, in coordination with the air liaison officer, plans, integrates, and coordinates the Air Force support for assault operations.
   f. **Aviation Unit Task** - See the OPORD for the specific mission assignments.
g. **Staging Plan** (both primary and alternate PZs).
   1. Pickup zone location.
   2. Pickup zone time.
   3. Pickup zone security.
   4. Flight route to PZ.
   5. Pickup zone marking and control.
   7. Attack and air reconnaissance helicopter linkup with lift elements.
   8. Troop and equipment load.

h. **Air Movement Plan**.
   1. Primary and alternate flight routes (SPs, ACPS, and RPs).
   2. Penetration points.
   3. Flight formations and airspeeds.
   4. Deception measures.
   5. Air reconnaissance and attack helicopter missions.
   6. Abort criteria.
   7. Air movement table.

i. **Landing Plan** (both primary and alternate LZs).
   1. Landing zone location.
   2. Landing zone time.
   3. Landing formation and direction.
   4. Landing zone marking and control.
   5. Air reconnaissance and attack helicopter missions.
   6. Abort criteria.

j. **Laager Plan** (both primary and alternate laager sites).
   1. Laager location.
   2. Laager type (air or ground, shut down or running).
   3. Laager time.
   4. Laager security plan.
   5. Call forward procedure.

k. **Extraction Plan** (both primary and alternate PZs).
   1. Pickup location.
   2. Pickup time.
   3. Air reconnaissance and attack helicopter missions.
   4. Supporting plans.

l. **Return Air Movement Plan**.
   1. Primary and alternate flight routes (SPs, ACPS, and RPs).
   2. Penetration points.
   3. Flight formations and airspeed.
   4. Air reconnaissance and attack helicopter missions.
   5. Landing zone locations.
   7. Landing zone marking and control.

m. **Coordinating Instructions**.
   1. Mission abort.
   2. Downed aircraft procedures.
   3. Inadvertent IMC (IIMC) recovery procedures.
(4) Weather decision by one-hour increments and weather abort time.
(5) Passenger briefing.

4. SERVICE AND SUPPORT
   a. Class I - - Food (Class A, B and MRE’s)
   b. Class III - - POL.
   c. Class V - - Ammunition and explosives.
   d. Class VIII - - Medical, MEDEVAC.
   e. Class IX - - Maintenance.
   f. Mission Oriented Protective Posture (MOPP) level.
   g. Pathfinder support - - FM frequency / call sign.
   h. Special mission equipment.
   i. Map sheets - - map series that will be used throughout the mission.
   j. FARP locations (primary and alternate).
   k. Ammunition and fuel requirements.
   l. Backup aircraft.
   m. Aircraft special equipment requirements, such as cargo hooks and command consoles with headsets.
   n. Health service support.

5. COMMAND AND SIGNAL
   a. Signal.
      (1) Radio nets, frequencies, and call signs.
      (2) Communications-electronics operation instructions in effect and time of change.
      (3) Challenge and password.
      (4) Authentication table in effect.
      (5) Visual signals.
      (6) Navigational aids (frequencies, locations, and operational times).
      (7) Identification friend or foe (radar) codes.
      (8) Code words for PZ secure, hot, and clean; abort missions; go to alternate PZ and LZ; fire preparation; request extraction; and use alternate route.
   b. Command.
      (1) Location of air assault task force commander.
      (2) Location of each Serial/Air Mission Commander
      (3) Point where air reconnaissance and attack helicopters come under OPCON as aerial maneuver elements.


7. Time Hacks.
   --All watches are synchronized.

8. Questions.

9. Commander’s Comments
A key factor to the success of aviation war fighting mission is thorough and detailed mission planning. The planner must gather and assimilate numerous bits of information, then develop the best plan. This section provides some basic guidelines and techniques for tactical flight mission planning.

The three methods of navigation in the UH-60 are Pilotage and Dead Reckoning (TC 1-237 Task 1044), Electronic-Aided Navigation (TC 1-237 Task 1046) and Terrain Flight Navigation (TC 1-237 Task 2024). Each method is unique, and together they form a triad that tells the pilot where the aircraft is, where it is going, and when it will get to its destination.

1. Maps - There are two basic maps used in tactical flight mission planning: the JOG and the tactical map.

*Joint Operations Graphic (JOG)*

a. The Joint Operations Graphic has a scale of 1:250,000. The scale of the map permits a relatively small map uncluttered with extraneous information. It shows coordinates in Latitude and Longitude, as well as Military Grid Reference System (MGRS). It is useful for performing long enroute legs performed at Low Level. However, because it lacks adequate terrain detail, it should not be used for Contour or Nap of the Earth (NOE) planning and navigation.
b. The tactical map has a scale of 1:50,000 and is a highly detailed map. This is the primary map used for the objective phase of the operation. It should be used anytime Contour or NOE flight is conducted, or anytime precise navigation is required (i.e. at a PZ or LZ).

NOTE: Care must be taken when transitioning from one scale of map to another, because the rate of movement over each map type changes with the scale. To prevent disorientation, select an easily defined checkpoint that is found on both maps to transition from one type of map to another.
2. Photographs - Aerial photographs can be extremely helpful. They show more detail than a map and are usually more up to date than the map information. If available, they should be requested for any part of the mission that warrants special attention. This may include LZ’s, PZ’s, etc.

3. Diagrams - These can be invaluable tools for briefing a mission. They should be prepared for all operations when time and opportunity permit. As a minimum, they should be prepared for the aircraft lineup and any primary, alternate, or false LZ/PZ’s.

4. Route Planning - The route for the mission must be tactically sound, yet not so difficult as to preclude successful navigation. The first step is to determine the threat situation. The following are considerations for planning and plotting the route:
   a. The easiest, quickest and least hazardous mode of flight is Low Level. It should be used whenever the threat situation allows.
   b. Contour and NOE are progressively slower, more difficult and more hazardous, and should only be used when the threat situation dictates.
   c. As a rule of thumb, use NOE when flying within the effective range of the threat weapon systems.
   d. Use Contour when flying within 10 -15 Kilometers of the maximum effective range of the threat weapons systems.
   e. Plan alternate ingress and egress flight routes.
   f. Locate the SP 3 to 8 kilometers from the PZ’s. The flight route starts here.
   g. Locate the RP 3 to 8 kilometers from the LZ’s, primary and alternate. The flight route ends here.
   h. Use prominent, distinct terrain features located along the flight route that facilitates navigation, control of speed, and control of en route fires as ACPs.
   i. Plan that no turn in the route exceeds 60 degrees, especially if slingloads are involved.
   j. Plan that routes are at least two kilometers wide.
   k. Ensure the course to the RP is within 30 degrees of the final course and the final course is within 30 degrees of the LZ landing heading.

5. General rules for terrain flight route selection and planning - Each mission will differ and involve numerous variables.
   a. If the threat allows, planning straight-line legs is the preferred method of navigation.
   b. Avoid built up areas and population centers.
   c. Avoid planning the route near navigational aids or airports.
   d. Plan the route to take advantage of cover and concealment.
   e. Use valleys and low ground to optimize the tactical considerations.
   f. Keep a terrain mass and / or navigation between the threat and the aircraft.
   g. Avoid planning route segments into a rising or setting sun or moon.
   h. Alter the course as needed, and fly a zigzag course when left with no other choice.
   i. During multi-aircraft missions, avoid heading changes of more than 5 degrees once past the release point for landing.
   j. Select intermediate reference points along the route, in addition to waypoints and ACP’s. This will aid navigation and timing.
   k. Plan to cross major roads and railroads at large angles (90 degrees) to reduce exposure.
   l. Avoid retracing your steps (for example, flying the same route into and out of the objective).
   m. When the threat situation dictates, plan primary and alternate contour or NOE flight routes.
   n. Alternate routes for other route segments may be required if weather or other factors force a deviation.
   o. Do not follow man-made linear features.
   p. Select routes where recognizable terrain features are located.
   q. Avoid open areas or large bodies of water where terrain permits.
   r. Plan routes over terrain that is inaccessible to wheeled or tracked vehicles.
   t. Be prepared to make in-flight changes to take advantage of better masking conditions.
6. Waypoint/Checkpoint Planning - - After a general route has been determined, select ACP’s, SP’s, RP’s and checkpoints to control movement along the route.

   a. Checkpoints are prominent features close enough to the route to aid in navigation. The following are some selection criteria for ACP’s, SP’s, RP’s, and checkpoints (collectively referred to as CP):

      (1) CP’s should be unique natural or manmade features which are detectable at a distance.
      (2) Avoid selecting CP’s near towns. If the town has grown since the map was published, the CP will be difficult to detect.
      (3) CP’s should be confirmed by at least one, but preferably two adjacent features. (For example, your CP may be a road intersection that you can confirm with a hill to the north and a church to the east).
      (4) Select a barrier at CPs that marks a turn.
      (5) Select a barrier at landing sites.

   b. The SP is the first checkpoint after take-off. It should be located 3–8 Kilometers out and within 30 degrees of the takeoff heading. It is the point at which the flight transitions from take-off to enroute flight.

   c. ACPs are plotted along the route of flight to define each segment of the route. ACPs indicate a point where the route turns, a point where there is a formation and/or mode-of-flight change, and/or a point to indicate distance. ACPs should be plotted 5 to 20 kilometers apart when using map scales of 1:100,000 or 5 to 20 nautical miles (NM) apart when using map scales of 1:250,000 and above. The ACP prior to the RP should be aligned within 30 degrees of the final leg.

   d. The RP is the most important CP. The RP is the last point before landing. It should be an easily identifiable feature within 3-8 kilometers of the landing site and should be aligned within 30 degrees of the landing direction. It is also the point where the flight transitions from enroute flight to landing, and usually assumes the landing formation.

7. Landing Zones Considerations (IAW TC 1-400 Chapter 4)

   a. The larger the number of LZs the higher the risk and complexity of the operation. Unless other METT-TC situations dictate, you should plan for no more than one primary and one alternate LZ.

   b. The sequencing of forces into the LZ is critical. Each serial must be ready to execute the ground tactical plan (GTP) from either the primary or alternate LZ. At each of the LZs, forces must land ready to fight. Forces should be organized on the PZ prior to departure, not the LZ. Using the following rules in prior planning make this possible:

      (1) Fly and land in the order of march/order of assault.
      (2) Ensure that each serial is able to fight as a team (combat cross loading).
      (3) Provide guidance (radio and visual) to the helicopters as they are inbound to the LZ; use pathfinders or scouts for en route guidance (at the RP) or on the LZ for terminal guidance. Pathfinder or other qualified Soldiers from the assault force lead serial may also be used for terminal guidance for subsequent serials inbound to LZ. Inbound guidance is not an option.
      (4) Separate serials by a minimum of one minute or more, based on conditions.
      (5) Land UH-60s at least 30 meters and CH-47s at least 35 meters out from the right or left tree line. This is critical to the deconfliction of fires and flight routing.

Note. The term tree line is used to refer to the area providing the best cover and concealment, and is a safe rushing distance from the aircraft. This area may be an actual tree line, building, revetment or other terrain feature.

      (6) Have aircraft land plus or minus 50 meters from the ground tactical commander’s (GTC’s) intended landing point (as per the air mission brief (AMB)).
(7) Have aircraft land plus or minus 30 seconds from the air movement table (AMT) touchdown time.
(8) Have aircraft land plus or minus 15 degrees from the planned landing heading.
(9) Ground forces can exit from one or both doors of the aircraft (METT-TC dependent).
(10) Ground forces offload aircraft within 30 seconds or less.
(11) Ground forces are in the tree line within 1 minute or less (after serial takeoff).
(12) Slingloads are landed and crews offloaded within 2 minutes or less.
(13) Vehicles are cleared from the LZ within 5 minutes of touchdown or less (this includes the 2 minutes of load landing and crew offload).

**Note:** Increase LZ size, as required, if serial time intervals are shorter between slingloads to allow loads to clear LZ. This allows subsequent serials/aircraft to maneuver avoiding loads if the ground unit cannot move a load off the LZ quickly enough.

c. The LZ is where the ground and aviation forces separate. Landing is the critical moment in any AASLT. Four UH-60 Blackhawks will require at least a 240-meter by 60-meter LZ/PZ (60 meters per UH-60) regardless of the mission. These are minimum planning requirements. Blowing dust, obstacles, or other hazards dictate larger PZs/LZs.

d. The assault force has the option to go out the left, right, or both doors. Whichever side(s) is planned, touchdown points, troop door exit, troop movement, aircraft door gunnery, and supporting fires are tied to that decision. Switching to the other side on the fly (an audible) can only occur with assured communications and before aircraft cross the RP. Changes must be relayed to all chalk leaders.

8. Cockpit Teamwork - - The ability of the crew to work as a team is crucial to the success of the mission. The navigator must give the pilot timely, clear and accurate information. The pilot should acknowledge that information and question anything not understood. Prior to arriving at a checkpoint the navigator should tell the pilot the following:

   a. The description of the checkpoint coming up.
   b. The direction and magnitude of the turn, if any.
   c. The change in airspeed, if any.

During low level flight, the navigator may give the pilot a specific altitude, airspeed, and heading or track (Doppler/GPS).

During contour or nap of the earth flight, the navigator must use guidance or rally terms that keep the pilot’s eyes outside the cockpit. When turns are needed, use clock positions, clearly identifiable terrain features and/or state “left/right turn” followed by “stop turn”. The pilot must have the latitude to make minor course deviations to best utilize the terrain for cover and concealment. The navigator must be flexible enough to allow these deviations, yet keep the aircraft on course and on time.

Examples:

“The next checkpoint is a dam. At the dam, you will be turning right to your two o’clock and slowing down to 60 knots groundspeed. I will let you know when to roll out and inform you when you have reached 60 knots.”

“Turn left to your ten o’clock.” or “Turn right and fly towards that saddle on the right side of the hill.”

“Right turn”, “Stop turn.”, “Turn to a heading of 240 degrees”
ANNEX C

Map Preparation

***** Review FM 3-04.203 Chapter 5 Dated 7 May 2007 for further guidance. *****

Map preparation is an important part of the mission planning process. It is imperative that maps be prepared accurately with extreme care and attention to detail. The following are some techniques and considerations to be used when you prepare your maps for Flight School XXI.

1. Use a marker or pencil that leaves a clear, legible line. Water-soluble pens work well, as the lines can be easily removed after the mission is over or to prevent compromise if captured.

2. Plot threat and/or restrictions.

3. Determine and place a tentative route on the map first, then place the SP’s, ACP’s, and RP’s (Remember that the RP is the most important point, and should be aligned with the landing direction). Adjust the route, if needed, to make the best use of features for SP’s, ACP’s, and RP’s, and double check that your route is tactically sound.

4. Determine and place alternate routes, as needed.

5. Place distance tick-marks along the left side of the course line. The tick-marks will start at the next succeeding waypoint counting up in the direction to the preceding waypoint. Place and number these tick-marks by each one-kilometer increment for the first five kilometers, then by each five-kilometer increment (see examples pages 24-27).

6. Determine the mode of flight and groundspeed to be flown for each segment of the mission.

7. Place time hack-marks along the right side of the course line. Time hack-marks should be placed every 1 to 1.5 minutes apart along the route. Where available, place them at identifiable features along the route. Time should start at the takeoff point and count up cumulatively along the route until landing.

8. Prepare maps available for a minimum of 10 kilometers on either side of the route in case the flight should depart the course line for any reason.

9. Do not over prepare the map. Too many lines may lead to confusion.

10. Transfer key features and hazards from VFR sectionals, tactical maps, and CHUM to the maps, as necessary.

11. All writing should be oriented in the direction of flight for that particular leg.

12. Standardize map preparation and symbology within the unit so that anyone can use a map prepared by another aviator.

CAUTION
Maps marked with classified information become classified and must be handled and stored according to security regulations.
ANNEX D

Map Symbology

***** Review FM 3-04.203 Chapter 5 Dated 7 May 2007 for further guidance. *****

The symbology for common features — such as railroads and power lines — should replicate the legend information available on the map sheet or exaggerate existing information printed on the map itself such as towers. The concern is clarity, simplicity, and immediate comprehension by any crewmember.

When preparing maps by hand, use fine or medium black markers for routes, ACPs, and time distance heading data. If printing maps, utilize a line color that contrasts with the background. Use red markers for hazards. Iridescent fine red/orange hue markers may be substituted to highlight wires and towers. An iridescent yellow marker may be used to highlight hydrographic features. Do not use blue markers as they cannot be seen under the blue filters used in the cockpit. Recommended map preparation symbology is:

- **Routes** - - will be marked on the map with a solid line.
- **Corridor boundaries** - - of a route will be marked on the map with alternating dashes and dots.
- **Alternate routes** - - will be marked with dashed lines
- **NOE routes** - - will be marked on the maps with dots

---

**Routes** - - will be marked on the map with a solid line.

**Corridor boundaries** - - of a route will be marked on the map with alternating dashes and dots.

**Alternate routes** - - will be marked with dashed lines

**NOE routes** - - will be marked on the maps with dots

---

**Unlit Tower**

**Lighted Tower**

**Towers** - - Symbol used to mark towers
Power Line - - Symbology to mark power line (They should also be highlighted)

Start and Release Point Symbol (SP & RP)  Air Control Point Symbol / Waypoint (ACP & WP)

These are placed along the course line for each route segment. The point of the symbol is oriented in the direction of the flight.

Landing Zone (LZ) / Pick Up Zone (PZ) / Objective Symbol  Doghouse – Next Waypoint, Heading, Distance and Time Symbol

NOTE: Other items may be placed on the map at your discretion. Be careful that you don’t obscure important features or let the map get too cluttered. On the next page is a sample route drawn using the planning and map preparation considerations found in this guide and FM 3-04.203 Chapter 5 Dated 7 May 2007.
SYMBOLOGY EXAMPLES WITH COMMENTS
### TACTICAL FLIGHT MISSION PLANNING AND MAP PREPARATION GUIDE

#### Groundspeed/Distance/Time Table

<table>
<thead>
<tr>
<th>KMs flown per minute</th>
<th>Knots G/S</th>
<th>KMs flown per minute</th>
<th>Knots G/S</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>16</td>
<td>0.9</td>
<td>30</td>
</tr>
<tr>
<td>1.0</td>
<td>33</td>
<td>1.2</td>
<td>40</td>
</tr>
<tr>
<td>1.5</td>
<td>49</td>
<td>1.5</td>
<td>50</td>
</tr>
<tr>
<td>2.0</td>
<td>65</td>
<td>1.8</td>
<td>60</td>
</tr>
<tr>
<td>2.5</td>
<td>82</td>
<td>2.1</td>
<td>70</td>
</tr>
<tr>
<td>3.0</td>
<td>98</td>
<td>2.5</td>
<td>80</td>
</tr>
<tr>
<td>3.5</td>
<td>114</td>
<td>2.8</td>
<td>90</td>
</tr>
<tr>
<td>4.0</td>
<td>130</td>
<td>3.1</td>
<td>100</td>
</tr>
<tr>
<td>4.5</td>
<td>147</td>
<td>3.4</td>
<td>110</td>
</tr>
<tr>
<td>5.0</td>
<td>163</td>
<td>3.7</td>
<td>120</td>
</tr>
</tbody>
</table>

An increase or decrease in G/S of 10 Knots = approximately 0.3 KM per minute

<table>
<thead>
<tr>
<th>Knots G/S</th>
<th>NMs flown per minute</th>
<th>Knots G/S</th>
<th>NMs flown per minute</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>0.5</td>
<td>105</td>
<td>1.75</td>
</tr>
<tr>
<td>35</td>
<td>0.58</td>
<td>110</td>
<td>1.83</td>
</tr>
<tr>
<td>40</td>
<td>0.67</td>
<td>115</td>
<td>1.92</td>
</tr>
<tr>
<td>45</td>
<td>0.75</td>
<td>120</td>
<td>2.0</td>
</tr>
<tr>
<td>50</td>
<td>0.83</td>
<td>125</td>
<td>2.08</td>
</tr>
<tr>
<td>55</td>
<td>0.92</td>
<td>130</td>
<td>2.17</td>
</tr>
<tr>
<td>60</td>
<td>1.0</td>
<td>135</td>
<td>2.25</td>
</tr>
<tr>
<td>65</td>
<td>1.08</td>
<td>140</td>
<td>2.33</td>
</tr>
<tr>
<td>70</td>
<td>1.17</td>
<td>145</td>
<td>2.42</td>
</tr>
<tr>
<td>75</td>
<td>1.25</td>
<td>150</td>
<td>2.5</td>
</tr>
<tr>
<td>80</td>
<td>1.33</td>
<td>155</td>
<td>2.58</td>
</tr>
<tr>
<td>85</td>
<td>1.42</td>
<td>160</td>
<td>2.67</td>
</tr>
<tr>
<td>90</td>
<td>1.5</td>
<td>165</td>
<td>2.75</td>
</tr>
<tr>
<td>95</td>
<td>1.58</td>
<td>170</td>
<td>2.83</td>
</tr>
<tr>
<td>100</td>
<td>1.67</td>
<td>175</td>
<td>2.92</td>
</tr>
</tbody>
</table>

An increase or decrease in G/S of 15 Knots = approximately 0.25 NM per minute

An increase or decrease in G/S of 10 Knots = approximately 0.17 NM per minute
The following are examples of individual cards that make up the Tactical Mission Kneeboard Packet.

---

**CREW/FREQUENCY CARD**

<table>
<thead>
<tr>
<th>C/S</th>
<th>F</th>
<th>U</th>
<th>V</th>
<th>Instructor</th>
<th>Pilots</th>
<th>Duties - CMD</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td></td>
<td></td>
<td></td>
<td>CW2 BECK</td>
<td>WO1 JONES</td>
<td>ALL</td>
</tr>
<tr>
<td></td>
<td>CW2</td>
<td>BECK</td>
<td></td>
<td>WO1 WILLIAMS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SET</th>
<th>FM</th>
<th>UHF</th>
<th>VHF</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMO CHECK</td>
<td>38.8</td>
<td>388.6</td>
<td>142.325</td>
</tr>
<tr>
<td>1</td>
<td>NW CORR 38.15</td>
<td>LOR TOWER 289.15(3)</td>
<td>CO INT 142.325</td>
</tr>
<tr>
<td>2</td>
<td>NW CORR 38.15</td>
<td>HUB CENTRAL 323.75(7)</td>
<td>CO INT 142.325</td>
</tr>
<tr>
<td>3</td>
<td>RT 399 30.55</td>
<td>HUB CENTRAL 323.75(7)</td>
<td>CO INT 142.325</td>
</tr>
</tbody>
</table>
# TACTICAL FLIGHT MISSION PLANNING AND MAP PREPARATION GUIDE

## FS21 UH60 TACTICAL ROUTE CARD

<table>
<thead>
<tr>
<th>ROUTE: FALCON (CONSECUTIVE)</th>
<th>FROM: LOWE</th>
<th>TO: RT399</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATUM: WGS84</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TIME</th>
<th>DISTANCE</th>
<th>FUEL</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TAKE OFF</td>
<td>LANDING</td>
<td>TOTAL</td>
<td>REQUIRED</td>
</tr>
<tr>
<td>00+00:00</td>
<td>00+00:00</td>
<td>43.6</td>
<td>427</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T/P</th>
<th>WP NAME</th>
<th>MAG CRS</th>
<th>LEG DIST</th>
<th>ETE</th>
<th>LEG FUEL</th>
<th>REM FUEL</th>
<th>GS</th>
<th>REMARK</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS POINT</td>
<td>MGRS</td>
<td>VAR</td>
<td>REMAIN</td>
<td>ETA</td>
<td>REM FUEL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOWE</td>
<td>360</td>
<td>0.0</td>
<td>00+00:00</td>
<td>0</td>
<td>COMM SET 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16R FV 1903 6946</td>
<td>3.0W</td>
<td>43.6</td>
<td>00:00:00</td>
<td>2100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 | SP1 | 307 | 3.6 | 00+01:27 | 16 | COMM SET 2 |
| 16R FV 1607 7142 | 3.0W | 40.1 | 00:01:27 | 2084 |

2 | ACP2 | 272 | 4.4 | 00+01:25 | 33 |
| 16R FV 1170 7129 | 2.9W | 35.7 | 00:02:52 | 2067 |

3 | ACP3 | 327 | 9.0 | 00+02:54 | 68 | COMM SET 3 |
| 16R FV 0642 7852 | 2.9W | 26.7 | 00:05:46 | 2032 |

4 | ACP4 | 337 | 5.4 | 00+01:46 | 90 |
| 16R FV 0399 8339 | 2.9W | 21.3 | 00:07:32 | 2010 |

5 | ACP5 | 310 | 9.6 | 00+03:07 | 128 |
| 16R EV 9627 8914 | 2.9W | 11.7 | 00:10:39 | 1972 |

6 | RP6 | 310 | 7.1 | 00+02:19 | 156 |
| 16R EV 9058 9345 | 2.8W | 4.5 | 00:12:58 | 1944 |

7 | RT399 | 327 | 4.5 | 00+01:50 | 177 |
| 16R EV 8793 9711 | 2.8W | 0.0 | 00:14:48 | 1923 |

**EXAMPLE OF TACTICAL ROUTE CARD (or TDH Card) CONSECUTIVE**
# FS21 UH60 TACTICAL ROUTE CARD

**ROUTE:** FALCON (RANDOM)  
**FROM:** LOWE  
**TO:** RT399  
**DATUM:** WGS84

<table>
<thead>
<tr>
<th>T/P</th>
<th>WP NAME</th>
<th>MAG CRS</th>
<th>LEG DIST</th>
<th>ETE</th>
<th>ETA</th>
<th>REM FUEL</th>
<th>GS</th>
<th>REMARK</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS POINT</td>
<td>MGRS</td>
<td>VAR</td>
<td>REMAIN</td>
<td>ETE</td>
<td>ETA</td>
<td>REM FUEL</td>
<td>GS</td>
<td>REMARK</td>
</tr>
<tr>
<td>LOWE</td>
<td>360</td>
<td>0.0</td>
<td>00+00+00</td>
<td>0</td>
<td>COMM SET 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>66</td>
<td>16R FV 1903 6946</td>
<td>3.0W</td>
<td>43.6</td>
<td>00:00:00</td>
<td>2100</td>
<td>COMM SET 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>RT2</td>
<td>307</td>
<td>3.6</td>
<td>00+01+27</td>
<td>16</td>
<td>80</td>
<td>COMM SET 2</td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>16R FV 1607 7142</td>
<td>3.0W</td>
<td>40.1</td>
<td>00:01:27</td>
<td>2084</td>
<td>COMM SET 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>ACP27</td>
<td>272</td>
<td>4.4</td>
<td>00+01+25</td>
<td>33</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>16R FV 1170 7129</td>
<td>2.9W</td>
<td>35.7</td>
<td>00:02:52</td>
<td>2067</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ACP51</td>
<td>327</td>
<td>9.0</td>
<td>00+02+54</td>
<td>68</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td>16R FV 0642 7682</td>
<td>2.9W</td>
<td>26.7</td>
<td>00:05:46</td>
<td>2032</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>NOLIN</td>
<td>337</td>
<td>5.4</td>
<td>00+01+46</td>
<td>90</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>16R FV 0399 8339</td>
<td>2.9W</td>
<td>21.3</td>
<td>00:07:32</td>
<td>2010</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>ACP5</td>
<td>310</td>
<td>9.6</td>
<td>00+03+07</td>
<td>128</td>
<td>100</td>
<td>COMM SET 3</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>16R EV 9627 8914</td>
<td>2.9W</td>
<td>11.7</td>
<td>00:10:39</td>
<td>1972</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>ACP6</td>
<td>310</td>
<td>7.1</td>
<td>00+02+19</td>
<td>156</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>16R EV 9058 9345</td>
<td>2.8W</td>
<td>4.5</td>
<td>00:12:58</td>
<td>1944</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RT399</td>
<td>327</td>
<td>4.5</td>
<td>00+01+50</td>
<td>177</td>
<td>80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>16R EV 8793 9711</td>
<td>2.8W</td>
<td>0.0</td>
<td>00:14:48</td>
<td>1923</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**EXAMPLE OF TACTICAL ROUTE CARD (or TDH Card) RANDOM**
### RT 399

**Grid:** EV 8793 9711  
**Freq:** 30.55  
**Lands:** 15/33  
**Remarks:** Terraced

<table>
<thead>
<tr>
<th>NAME</th>
<th>GRID</th>
<th>ELEVATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>RT 399</td>
<td>16R EV 8793 9711</td>
<td>168FT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FORMATION</th>
<th>FREQ / CS</th>
<th>ENTRY / EXIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINGLE</td>
<td>30.55</td>
<td>LEFT / REAR / RIGHT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DIRECTION</th>
<th>GO AROUND</th>
<th>ALTERNATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>15/33</td>
<td>LEFT</td>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MARKINGS NEAR / FAR PORTMAN DEVICE</th>
<th>HAZARDS</th>
<th>WEAPONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TERRACED / SLOPES N-S</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LOAD</th>
<th>FUEL</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA</td>
<td></td>
<td>R. TFC ONLY (EXAMPLE)</td>
</tr>
</tbody>
</table>

**330 Approach**

---

EXAMPLE OF LZ/PZ CARD
### WAYPOINT CARD

<table>
<thead>
<tr>
<th>WP #</th>
<th>WAYPOINT</th>
<th>GRID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LOR (Copy from 66)</td>
<td>16R EV 1903 6946</td>
</tr>
<tr>
<td>2</td>
<td>RT2 (Copy from 67)</td>
<td>16R FV 1607 7142</td>
</tr>
<tr>
<td>3</td>
<td>ACP27 (Copy from 68)</td>
<td>16R FV 1170 7129</td>
</tr>
<tr>
<td>4</td>
<td>ACP51 (Copy from 69)</td>
<td>16R FV 0642 7852</td>
</tr>
<tr>
<td>5</td>
<td>NOLIN (Copy from 70)</td>
<td>16R FV 0399 8339</td>
</tr>
<tr>
<td>6</td>
<td>ACP6</td>
<td>16R EV 9627 8914</td>
</tr>
<tr>
<td>7</td>
<td>RP7</td>
<td>16R EV 9058 9345</td>
</tr>
<tr>
<td>8</td>
<td>RT 399 (Copy from 32)</td>
<td>16R EV 8793 9711</td>
</tr>
</tbody>
</table>

**EXAMPLE OF WAYPOINT CARD**
Multi-Aircraft Operations

1. Multi-aircraft operations involve two or more aircraft flying together in briefed formations or while performing combat maneuvers.

2. Formation flight allows effective employment and control of two or more aircraft to accomplish a mission. The strengths of formations include control, predictability, flexibility, mutual support, and threat detection. These basic maneuvers and formations work well for team operations and can be enlarged to accommodate platoon size and larger formations.

3. Common formations used during multi-aircraft operations include fixed formations (such as echelon, staggered, or trail) and maneuvering formations (including combat cruise and combat spread). Army aviators should be familiar with basic formations and maneuvers described in the following paragraphs. All angles and distances can be modified based on aircraft and mission. The two helicopter team/section is the building block for all formations from which can be built upon to create platoon- and company-sized formations (See below the Two-Helicopter Section/Element Example). The intent is to allow aircraft to be able to fly together using common terminology and techniques. The only authorized formations for night/NVG flight at 80 feet AHO and below are combat cruise formations in conjunction with techniques of movement according to TC 1-210.

4. Two-Helicopter Team. A team usually consists of two helicopters flying as lead and wingman. The wingman may fly to the left or right rear of the lead aircraft. When flying to lead’s left rear, the wingman is flying in echelon or staggered left. When flying to the lead’s right rear, the wingman is flying in echelon or staggered right. The correct angular location is approximately 45 degrees with consideration given to aircraft limitations.

5. Fixed Formations. These formations are used when more control is required. The flight acts as one aircraft regardless of the number of aircraft in the flight, and the movements of lead are mirrored throughout the flight. Fixed formations are useful for departure and arrival at LZs, airfields, administratively transiting airspace, deployment, and when environmental conditions do not allow or require tactical separation. When lead locks the wingman into these fixed formations, lead must consider the wingman’s obstacle clearance and provide appropriate horizontal and vertical clearance. Wingmen, as well as lead, must consider the reduction in altitude.
wingmen have when flying on the inside of turns and ensure adequate obstacle/terrain clearance. Spacing and separation must be considered during changes in altitude and headings.

a. Staggered. This is one of the most commonly used formations in Army aviation and is flown as a staggered right or staggered left (See below Staggered Right and Left Formation Example). Each aircraft of the formation holds a position approximately 45 degrees astern of the aircraft to its front, alternating left and right. Chalk 2’s position determines if the formation is staggered right or staggered left. Chalk 3 (and any other odd-numbered wingmen) flies in trail directly behind lead. A staggered formation is essentially a continuous, alternating series of the basic two helicopter section/element. This formation is not limited to any prescribed number of aircraft. The mission requirement dictates its size. This formation gives wingmen the ability to estimate distance and rates of closure and allows some flexibility in relation to adjacent aircraft while affording lead control of the flight. Staggered formations are common formations used through congested airspace, for large formations in a low-threat area, for air assault approaches and takeoffs, or for traveling through narrow canyons. Formation changes between a left and right staggered formation are directed by lead. During the crossover, wingmen maintain appropriate clearance. Chalk 2 should use a heading change of approximately 5 to 10 degrees to cross from one side to the other. Chalk 3 maintains position behind lead. A slight vertical stacking is recommended during the crossover to avoid rotor wash. Staggered formation has the following advantages and disadvantages:

1) Advantages:
   a. Fixes position of wingmen.
   b. Allows lead maneuverability.
   c. Simplifies prepositioning of loads.
   d. Allows rapid deployment of troops for all-around security.

2) Disadvantages:
   a. Increases pilot workload to maintain relative position to the aircraft in front of it when flying tight or close.
   b. Requires a relatively long and wide landing area.
   c. Places some restriction on suppressive fire by door gunners.

![Staggered Right and Left Formation Diagram](image-url)
b. Trail Formation. The trail formation is the most difficult of the fixed formations (See Trail Formation Example). Each wingman/chalk follows leads movement within 10 degrees of the preceding aircraft. Trail formation can be used for landings and takeoffs and as a transition during formation changes. Trail formations should not be flown for extended periods of time as distances and rates of closure between aircraft are difficult to determine. It is important to note flight at the 6 o’clock position makes it very difficult for the preceding aircraft to scan for wingmen and can degrade SA in the flight. Trail formation has the following advantages and disadvantages:

1) Advantages.
   a. Simplifies prepositioning of loads.
   b. Allows nearly unrestricted suppressive fire by door gunners.
   c. Allows rapid deployment of troops to the flanks.

2) Disadvantages.
   a. Creates difficulty in interpreting aircraft spacing and relative motion while in flight, especially during night flight–aided or unaided.
   b. Presents a poor choice during dust/sand/snow takeoffs and landings. Aircraft can be engulfed by the cloud of the preceding aircraft.
   c. Requires a relatively long landing area.

6. Vertical Separation. Flat, stepped-up (See Stepped-up Vertical Separation Example), and stepped down are vertical separations.

   a. Flat. All aircraft are flown at the same altitude.
   b. Stepped-up. Vertical separation of 1 to 10 feet higher between lead, chalk 2, and each successive aircraft.
   c. Stepped-down. Vertical separation of 1 to 10 feet lower between lead, chalk 2, and each successive aircraft.

   **Note.** In stepped-down formation, trailing aircraft may experience wake turbulence. To avoid this turbulence, they will need to adjust their relative position. Trailing aircraft require more power to fly in this formation.

7. Multi-Aircraft Operations Briefing. Regardless of the number of aircraft in the formation, the lead/wing concept should be applied. During multi-aircraft operations, additional crew actions must be considered. All multi-aircraft operations are briefed using a unit approved multi-aircraft/mission briefing checklist and should include the following:

   a. Formation type(s).
   b. Altitudes.
   c. Airspeeds.
   d. Aircraft lighting.
   e. Lead change procedures.
   f. Loss of visual contact/in-flight link-up.
   g. Loss communications procedures.
h. IIMC procedures.

i. Actions on contact.

j. Downed aircraft procedures.

k. Separation.

8. Formation Takeoff.

a. A formation takeoff is two or more aircraft leaving the ground simultaneously and then maintaining a pre-designated relative position during the takeoff. Most formation takeoffs are made from the ground and liftoff simultaneously at a prearranged signal from the lead aircraft. The leading aircraft should accelerate slightly faster than a VMC takeoff, allowing the following aircraft to gain translational lift; care must be taken, however, to not accelerate too quickly and leave the flight scrambling to catch up. The initial rate of climb must be enough to clear barriers with a safety margin. Trailing aircraft maneuver into the en route formation and attain a stepped-up vertical separation as soon as possible permitting acceleration and climb to undisturbed air.

b. Once the flight is airborne and established, the lead aircraft can slowly and smoothly accelerate to normal climb or cruise airspeed. Takeoffs should only be into the wind, especially for dust/sand/snow conditions. For moderate to heavy dust/sand/snow conditions, aircraft should take-off separately in chalk order and then conduct an in-flight join-up.


a. Formation flying is the maneuvering of aircraft according to established tactics, techniques, and procedures (TTP). It includes rapid, but controlled, change from a specific formation suitable for one set of conditions to another formation meeting requirements of an entirely different set of conditions. Safe and orderly formation flight is the result of extensive training, continuous practice, and a high degree of discipline.

b. The aviator flying each aircraft maneuvers with primary reference to only one other aircraft. The constant vigilance necessary to fly, reference the other aircraft, avoid obstacles, and incorporate an instrument scan precludes the P* from observing other aircraft. However, P can observe aircraft other than the primary reference aircraft. In formation types requiring observation of two aircraft such as diamond or staggered, the P* must do so with great care and precision while mainly viewing the primary aircraft.

c. Aviators must anticipate aerodynamic interference between aircraft during formation flight. Aviators flying trailing aircraft may encounter wake turbulence if they permit their aircraft to go below the leading aircraft. Flight in turbulence may result in rapid attitude (pitch, roll, and yaw) changes.

d. Distance between aircraft can be increased or decreased to fit the tactical situation. At terrain flight altitudes, aircraft may spread out to take advantage of the terrain/tactical situation. In addition, it is less fatiguing to fly loose or extended formations as opposed to tight or close formations.

e. All aircraft should have the pilot not on the controls navigating in the event they must take over the lead position and assist the flight with ensuring navigational accuracy to complete the mission.

f. Altitude and airspeed changes should be smooth and gradual especially during tight and close formations. This allows all aircraft in the formation to act in unison. Abrupt changes in altitude and airspeed by the lead aircraft may cause an “accordion” effect. This results when all remaining aircraft in the formation make correspondingly abrupt altitude and airspeed changes to maintain their relative position and the effects are magnified as the flight progresses. When flown incorrectly, aircraft toward the rear of a formation may experience excessive rates of closure as they attempt to maintain their relative positions.
10. Formation Turns.

The lead aircraft should make smooth constant rate turns and avoid angles of bank greater than 30 degrees. Turns at reduced bank angles require larger turning radiiuses, particularly in the landing pattern, and must be considered in planning. If a large turn is required, flight lead enters the turn as early as possible to avoid excessive bank angles and subsequent recovery. This allows the flight to react in a timely manner. During a turn, the inside aircraft must decelerate slightly and drop slightly lower than the leading aircraft, while the outside aircraft must accelerate slightly and climb slightly to maintain its position in the formation. Whenever possible, the aviator avoids turns in which aircraft are forced inside the lead aircraft’s turning arc. This is usually addressed during the planning process and briefed accordingly. Aircrews should avoid planning route segments requiring heading changes of more than 60 degrees.

11. Formation Changes during En Route Flight.

Formation changes en route require a high degree of proficiency and therefore are executed with caution and only when necessary. Any changes to a formation are specifically briefed and understood by all aircrews involved. As a technique, trail formation could be used as a transitional formation before executing the next briefed formation. All flight lead changes with students will be conducted on the ground, not in flight.

12. Lead Changes.

Lead changes are inherently difficult, potentially dangerous, and should be executed on the ground, whenever possible. A lead change is never initiated, day or night, by accelerating to overtake the lead aircraft. Only the lead aircraft may give the signal to initiate lead changes. Flight lead initiates by a prearranged signal, and the flight acknowledges beginning with chalk 2. The lead aircraft then makes a 30- to 90-degree heading change in the pre-briefed direction to depart the formation and establish separation space. Lead maneuvers a minimum of eight rotor disks to the announced side and begins to parallel the formation. When chalk 2 (the new lead) confirms and announces the former lead is clear of the flight, the former lead will slow to 10 KIAS less than the en route airspeed. The former lead visually (and possibly verbally) confirms each aircraft in the flight as it passes to prevent rejoining the flight prematurely causing a midair collision. After the last aircraft (former trail) has passed by, the former lead aircraft will rejoin the flight and assume the duties of the trail aircraft to include displaying appropriate lighting. The former trail aircraft then reconfigures its lighting to conform to the rest of the formation.


a. All aircraft touch down at the same time while maintaining their relative positions (no less than one rotor disc separation) within the flight. The rate of closure throughout approach and landing is somewhat slower at night than during the day. Flight lead should maintain straight-and-level flight until the desired approach angle is intercepted. Lead then maintains a constant approach angle and, where terrain and obstacles permit, makes the approach to the ground avoiding hovering turbulence and brownout or whiteout conditions. If the rate of closure is too fast, the aviator should avoid S-turns to lose airspeed. Instead, execute a go-around if unable to slow to the appropriate airspeed, especially with heavily loaded aircraft.

b. Lead must plan to touch down far enough forward in the PZ/LZ to provide sufficient landing space for the entire flight. When planning the touchdown, consideration should be given to obstacles and power availability on the departure. If potential whiteout or brownout conditions exist, the flight may have to spread out to the briefed landing disk separation before the approach is established facilitating safe landing conditions. The AMC should consider, based on aviator experience and the environment, stacking down and landing in reverse chalk order once flight lead initiates an approach. This reduces the possibility of being caught in the cloud from the preceding aircraft. Finally, if safety is in doubt regarding landing or landing conditions, the flight lead should execute a go-around. The go-around should be executed prior to descending below any obstacles or losing ETL to prevent sudden high power demands on the other aircraft.

a. Helicopter flight crews must be trained to cope with marginal weather conditions they may encounter during formation flight. All multi-helicopter operation mission briefs must include a planned response for encountering IIMC. As well as being an established part of an SOP, IIMC must be planned and briefed for all phases of the mission. During the breakup procedure, all aircraft should remain in contact with the lead aircraft and also contact ATC in chalk order for further guidance. Communication is key to a safe execution of this procedure. Aviators should perform all turns, airspeeds, and climbs at a predetermined standard rate. They should maintain prescribed headings and altitudes for each aircraft at least 30 seconds after breakup to gain separation before executing any additional procedures. The following procedures are guidelines for units to further develop their own procedures, based on mission, terrain, weather, and enemy situation.

b. Breakup Procedure. It is unlikely more than two or three aircraft will enter IIMC before the situation is recognized and remaining aircraft take prebriefed evasive action. Vigilance, communication, and SA are important factors in avoiding IIMC. If any aircraft encounters IIMC, they will notify the rest of the flight via the radio using a prebriefed code word or plain language. An example call would be “Lead is IMC, executing breakup procedure, heading 090”. The lead aircraft heading is important as the other aircraft will plan their headings accordingly. A good heading choice is 10 degrees times chalk position from lead’s announced heading to the clear side of the formation. Upon hearing this message, the formation begins the breakup procedure (if unable to remain VMC) according to the prearranged plan. When aviators initiate IIMC recovery, the following procedures—for a staggered formation—are suggested. The following information relates to Formation breakup – IIMC example below.

1. Flight lead continues straight ahead and reports the magnetic heading and altitude he will climb to and maintain.
2. Chalk 2 executes a 20-degree turn away from the flight (if staggered left, chalk 2 would turn left) and climbs 500 feet higher than the lead aircraft.
3. Chalk 3 executes a 30-degree turn away from the flight (if staggered left, chalk 3 would turn right) and climbs 500 feet higher than chalk 2 (1,000 feet higher than lead).
4. Chalk 4 executes a 40-degree turn away from the flight (if staggered left, chalk 4 would turn left) and climbs 500 feet higher than chalk 3 (1,500 feet higher than lead).
5. Chalk 5 executes a 50-degree turn away from the flight (if staggered left, chalk 5 would turn right) and climbs 500 feet higher than chalk 4 (2,000 feet higher than lead).
c. There are many variations to this technique (lead climbs to highest and others stack down 500 feet); however it offers the simplicity of correlating chalk number to the number of degrees turning. In addition, the direction of turn is simplified by stating, in staggered left formation as an example, even-numbered chalk positions turn left and odd-numbered chalk positions turn right. While an additional 500 feet might seem excessive for each chalk number to climb above the previous chalk number, this technique offers an additional safety margin. Considerations for IIMC procedures include the following:

1. Enemy ADA capabilities.
2. Terrain elevation and relief.
3. Emergency minimum safe operating altitude.
4. Availability of location of recovery airfields.
5. Fuel considerations.
6. ACO requirements.
7. Turns should not exceed standard rate.
8. When flying near hostile borders and prohibited or restricted areas, consideration must be given to avoid flying into these areas.
9. IIMC should be briefed when forecasted weather conditions are less than 1,000/3.
10. Mountainous terrain requires detailed IIMC and innovative planning.
ANNEX G

Sling Load Operations

***** Review TC 1-237 Task 2048, FM 90-4, FM 3-04.203, and FM 4-20.197 for further guidance. *****

1. Sling Load Operations - - (TC 1-237 Task 2048, FM 90-4 Chapter 6, FM 3-04.203 Chapter 2, FM 4-20.197 Appendix A)
   
   a. Load categories: High density, low density and aerodynamic.
   b. Situations that favor sling loads.
   c. Basic sling load procedures.
   d. Hand and arm signals.
   e. Emergency actions during hook-up/in-flight load oscillations.
   f. Sling Load site set-up.
   g. Performance Planning Considerations.

2. Example of standard words and phrases for sling load operations - - IAW TC 1-237 Task 2048

<table>
<thead>
<tr>
<th>“Hook is armed”</th>
<th>“Load is hooked”</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Load under the nose”</td>
<td>“Hookup crew clear”</td>
</tr>
<tr>
<td>“Load in sight”</td>
<td>“Slings coming tight”</td>
</tr>
<tr>
<td>“Forward”</td>
<td>“Load is centered”</td>
</tr>
<tr>
<td>“Back”</td>
<td>“Load is off the ground”</td>
</tr>
<tr>
<td>“Left”</td>
<td>“Load on ground”</td>
</tr>
<tr>
<td>“Right”</td>
<td>“Slack in the slings”</td>
</tr>
<tr>
<td>“Down”</td>
<td>“Release the load”</td>
</tr>
<tr>
<td>“Up”</td>
<td>“Load is released”</td>
</tr>
<tr>
<td>“Hold”</td>
<td>“Clear to reposition”</td>
</tr>
</tbody>
</table>


   a. Application - - Helicopters are frequently used to move cargo externally (sling loads) when heavy, outsized, or needed-now items are required to be rapidly transported over untenable terrain. The following situations favor the use of external loads:

   - Cargo compartment of the aircraft is too small.
   - Aircraft CG would be exceeded, due to the characteristics of the load, if loaded internally.
   - Loading and/or unloading must be accomplished in the shortest possible time.
   - PZ/LZ conditions prevent aircraft from touching down.
   - Nature of cargo is such that rapid cargo-jettison capability is desirable.

   b. Load Categories - - All external loads are divided into three basic categories—high-density, low-density, and aerodynamic. Each exhibits different characteristics in flight. High-density load offers the best stability; low-density load is the least stable. The aerodynamic load exhibits both instability and stability (instability inherent until load streamlining occurs). An aviator must determine category, size, and weight of the load during preflight.
c. Cargo Nets and Slings - Cargo nets and slings are an essential part of the external-load operation and must be given the same attention during the preflight inspection as the cargo receives. Nets and slings with frayed or cut webbing will not be used for external loads. Due to critical strength requirements, field sewing of nylon should not be attempted, nor should nonstandard parts be substituted in assembling slings. The sling assembly must be commensurate with load requirements and must meet requirements in the operator's manual.

d. Aircraft Performance and Operator’s Manual - It is imperative aviators consult the appropriate operator’s manual to ensure a successful operation. Performance charts in this manual include gross-weight limitations, airspeed limitations, and endurance charts. The gross-weight chart provides a rapid means of determining load-carrying capabilities within safe operating limits. This performance planning data is crucial to successful sling-load operations. The operator's manual also gives a complete operational explanation of sling-release systems. During preflight, aviators must inspect emergency-release systems and make operational checks of all normal release modes. Emergency procedures for any nonstandard occurrence experienced during external-load operations are outlined in the operator's manual.

e. Coordination with Flight and Ground Personnel - Preflight is not complete until the aviator briefs the flight and ground crews on their duties and mission to be performed. Essential criteria for a safe operation are predetermined prior to takeoff. Signaling procedures, unit standing operating procedures (SOPs), and emergency procedures are in the brief.

f. Weight, Balance, and Loads

1. Using a completed DD Form 365-4, verify that the aircraft gross weight (GWT) and center of gravity (CG) will remain within allowable limits for the entire flight. Note all GWT, loading task/maneuver restrictions/limitations. If there is no completed DD Form 365-4 that meets mission requirements, the PC will ensure adjustments are made to the existing DD Form 365-4.

2. Prior to sling load operations, a qualified sling load inspector must inspect/certify the load, record the certification on a DA Form 7382 and provide a copy to the aircrew.

g. Sling load pickup procedures - Pickup techniques varies according to the helicopter in use, type and weight of the external load, terrain involved, and wind and weather conditions at time of pickup.

1. Approach Procedure - The approach to hookup (also release) should be conducted into the wind, yielding best aircraft stability and performance. Even if the load is light and there is excess power, the wind could be the critical factor during emergencies. A slow forward hover allows the aviator to receive directions from flight crew and ground personnel without jeopardizing the aircraft or hookup person’s safety. When directions are received solely from ground personnel, a signalman must be in a plain view position of the aviator and give appropriate visual signals throughout the operation. The cargo-release switch is placed in the arm position as the aircraft approaches the load.

2. Hover Altitude - The appropriate hover altitude depends upon variables such as type of helicopter, terrain and ground effect, size of load, and safety of the ground crewmen. Once an altitude is decided, it should be kept constant to prevent false perception and possible load strike. To assist the pilot in maintaining a constant position and hover altitude, references should be selected in the front and to the sides of the helicopter.

3. Hookup Procedure - Hookup commences with final positioning of the helicopter over the load. This normally is conducted through verbal coordination with a flight crewmember that is in a position to closely observe the helicopter's movements over the load. In helicopters where flight crews are unable to observe the helicopter's movements over the load, a signalman located on the ground and in plain view of the aviator must be used. In all cases, the signals (verbal or visual) must be standardized.
among the persons involved prior to the operation (see FM 4-20.197). The load is attached to the helicopter's cargo hook by the hookup crew when the helicopter is stabilized over the load.

h. **Emergency Actions** - - In the event an emergency condition occurs while hovering over the load and the helicopter must be landed, the helicopter normally will land to the left of the load. Hook-up personnel must move in the opposite direction (to the right of the helicopter) to avoid injury. The unit SOP establishes this procedure and the aviator must brief all personnel before conducting external-load operations. The hookup man will approach from the helicopter’s right and exit to the helicopter’s right. When possible, ground personnel should not position themselves between the load and the helicopter during hookup. The load is to be attached according to the appropriate operator's manual, FM 4-20.197, and the unit SOP. Hookup personnel notify the pilot immediately when the load is attached to the cargo hook. Any emergency procedure following attachment must include cargo release.

i. **Takeoff Procedure** - - There are two distinct phases when taking off with an external load—lifting the load to a hover and takeoff.

1. **Lifting the Load to a Hover** - - Once the signalman indicates the load is hooked up and the hookup man is clear, the aviator initiates a slow vertical ascent until the sling becomes taut and centered. The aviator, flight crew, and/or ground crew closely coordinate ensuring the aircraft does not drift from over the load. The load is then slowly lifted to an appropriate hover altitude (normally about 10 feet above the ground). While picking up the load to a hover, the aviator must determine whether the helicopter has sufficient power to continue the operation. Security and proper rigging of the load are also reconfirmed.

2. **Takeoff** - -After receiving the takeoff signal from the signalman and if all criteria have been met for flight, smooth acceleration and takeoff are initiated. Sufficient power (not to exceed maximum allowable) is applied on takeoff ensuring the load clears all obstacles by a safe altitude. Once established at a safe altitude, power is adjusted to maintain safe airspeed and altitude. The cargo-release switch is placed in the safe position after passing through above ground level (AGL) altitude as directed by the operator’s manual and/or SOP. During flight below this altitude, the cargo-release switch is left in the arm position. Aviators should avoid flight over populated areas.

Note. A safe climb altitude is the altitude wherein the load is unquestionably clear of the highest barrier, usually 50 to 100 feet above the tallest immediate obstacle.

j. **En-route performance** - - The weight and density of the load may determine airworthiness (steadiness in flight) and maximum airspeed at which the helicopter may be safely flown. Low-density, light loads generally tend to shift farther aft as airspeed is increased and may become unstable. When the load is of greater density, more compact, and balanced, the ride is steadier and airspeed may be safely increased. Any unstable load may jump, oscillate, or rotate resulting in loss of control and undue stress on the helicopter. This requires reducing forward airspeed immediately, regaining control, and steadying the cargo load. If an external load begins oscillating fore and aft, the helicopter should be flown into a shallow bank while decreasing airspeed. This normally shifts the oscillation laterally which can easily be controlled by further decreasing forward airspeed. At the first indication of a buildup in oscillation, it is mandatory to slow airspeed immediately. The oscillation may endanger the helicopter and personnel. This situation may require jettisoning the load. For a complete explanation of the cargo release system for the helicopter to be flown, see the appropriate operator's manual.
k. Termination and release procedures - Termination and subsequent load release must include approach to the termination point, hovering to the load-release point, and releasing the load.

1. Termination Point Approach - The approach to the termination point should not be initiated until the appropriate termination point is identified. At the appropriate altitude, the cargo-release switch is placed in the arm position.

2. Load-Release Point Hovering - Procedure at the load-release point will be accomplished in the same manner as described earlier in external load pickup procedures. The procedure, however, reverses over the load-release point.

3. Load Release - Stabilize the aircraft over the load and descend to allow slack in the sling. If possible, to prevent damage, slide the aircraft laterally to where the clevis will not fall on the load. When the aircraft is clear of the load, open the cargo hook to release the load. Usually the cargo hook is opened through the normal release modes of operation, in accordance with appropriate aircraft operator's manual. Manual and emergency release methods will be used in accordance with the appropriate operator's manual and the unit SOP when normal modes fail to function properly. Ground personnel, in accordance with SOP and other directives, may use any means necessary to free the load if the cargo cannot be released from the helicopter by the flight crew. These methods might include use of knives, bayonets, or blade-like instruments to cut nylon or rope components of the sling assembly. When metal components must be cut to free a load, devices such as diagonal cutters, bolt cutters, pliers, or cable cutters are appropriate.
## Hand and Arm Signals


<table>
<thead>
<tr>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Assume Guidance](image) | Assume Guidance  
Arms extended vertically straight up, palms forward |
| ![Hover](image) | Hover  
Arms extended horizontally sideways, palms downward |
| ![Move Forward](image) | Move Forward  
Arms a little aside, palms facing backwards, and repeatedly move upwardbackward from shoulder height |
MOVE BACKWARD
ARMS BY SIDE, PALMS FACING FORWARD, ARMS SWEPT FORWARD AND UPWARD TO SHOULDER HEIGHT

MOVE UPWARDS
ARMS EXTENDED SIDEWAYS, BECKONING UPWARDS, WITH PALMS UP

MOVE DOWNWARDS
ARMS EXTENDED SIDEWAYS, BECKONING DOWNWARDS, WITH PALMS TURNED DOWN

MOVE TO RIGHT
LEFT ARM EXTENDED HORIZONTALLY SIDEWAYS IN DIRECTION OF MOVEMENT AND OTHER ARM SWUNG OVERHEAD IN SAME DIRECTION, IN A REPEATING MOVEMENT

MOVE TO LEFT
RIGHT ARM EXTENDED HORIZONTALLY SIDEWAYS IN DIRECTION OF MOVEMENT AND OTHER ARM SWUNG OVERHEAD IN SAME DIRECTION, IN A REPEATING MOVEMENT
| ![Affirmative Signal](image) | **Affirmative Signal**  
Hand Raised, Thumb Up |
| --- | --- |
| ![Hookup](image) | **Hookup**  
Raise hands alternately above the head in a “rope climbing” motion to take up slack |
| ![Negative Signal](image) | **Negative Signal**  
Hand Raised, Thumb Down |
| ![Takeoff](image) | **Takeoff**  
Make a circular motion with right hand overhead ending in a throwing motion in the direction of takeoff, also means load clear, hookup good |
| ![Land](image) | **Land**  
Arms crossed and extended downwards in front of the body |
<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>STOP</strong></td>
</tr>
<tr>
<td>Hold arms crossed overhead, do not move</td>
</tr>
<tr>
<td><strong>WAVE OFF – DO NOT LAND</strong></td>
</tr>
<tr>
<td>Cross arms repeatedly overhead</td>
</tr>
<tr>
<td><strong>RELEASE SLING LOAD</strong></td>
</tr>
<tr>
<td>Left arm extended forward horizontally, fist clenched, right hand making horizontal slicing movement below the left fist, palm downward</td>
</tr>
</tbody>
</table>
### Example Series of Hand Signals for a Pickup Zone During a One Aircraft Operations

<table>
<thead>
<tr>
<th>Assume Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Assume Guidance Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Moving the Aircraft</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Left</strong></td>
</tr>
<tr>
<td>![Left Illustration]</td>
</tr>
<tr>
<td><strong>Right</strong></td>
</tr>
<tr>
<td>![Right Illustration]</td>
</tr>
<tr>
<td><strong>Back</strong></td>
</tr>
<tr>
<td>![Back Illustration]</td>
</tr>
<tr>
<td><strong>Forward</strong></td>
</tr>
<tr>
<td>![Forward Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hover</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Hover Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hookup (Your Load is Attached)</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Hookup Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Move Upward</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Move Upward Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Affirmative Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Affirmative Signal Illustration]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Takeoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Takeoff Illustration]</td>
</tr>
</tbody>
</table>
If a problem occurs on a load when the aircraft raises up and the slings tighten, follow these directions:

**Hookup**
(Followed quickly by a negative signal)

**Move Downward**

**Hover**
(While the ground crew corrects the load)

**Release Sling Load**
(if necessary)

Once the load is corrected go back to normal hookup procedures.

*If the problem cannot be corrected by this method, give the pilot the release the load signal*
ANNEX I
Combat Flight Planning System (CFPS) and Falcon View


A. Open CFPS

1. On the Mission Binder toolbar, click CFPS
2. Start > Programs > PFPS > CFPS
3. Or open using Task Manager.

B. Preflight the Program

1. Premission Configuration button on toolbar, or Configuration under Premission pulldown menu.

NOTE: Changes in CFPS PreMission Configuration will only affect this mission. To change defaults, changes must be made in CFPS System Admin.

a. Select Configuration tab and ensure settings, such as aircraft type, initial weight and drag figures are correct. Attach Standard Configuration Load (SCL), if required.

NOTE: If using an SCL, external fuel, store weight, and total drag will be adjusted automatically.

b. Select Fuel tab and ensure fuel settings are correct.

c. Select Route tab and adjust departure date, attach CARP and modify other options as required.

d. Select FOB/RES tab and select YES for Compute FOB/RES. This tab is the source of data for the DD-175 FOB/RES field. If you commonly receive calculation errors due to this setting, use MANUAL mode with appropriate fuel flows.

b. Select Divert tab and ensure divert flight modes are correct.

C. Entering CFPS Route Points

1. ICAO ID’s, Waypoint names, Local Points, and DAFIF Routes
a. Enter ICAO ID’s (airports or Navaids), five letter Waypoint names, or Local Point names directly into the Fix/Point field. Program will automatically search the database and fill in Lat/Long, Elev, MV, Altitude, and standard day Temp values after hitting Tab or Enter. Points entered in Fix/Point field will be in **boldface**. These entries will remain unchanged if the route is updated with new DAFIF info.

**NOTE:** If entry is not recognized by CFPS (non-DAFIF), a decimal point (.) will be inserted before entry. Lat/Long will remain all zeros.

b. Enter DAFIF route names (Airways, MTRs, AR tracks) directly by typing letters and numbers without spaces or dashes (ex. J28, VR1010, AR330). After selecting Tab or Enter keys the Airway Selection dialog, MTR Wizard, or AR Wizard/AR Tool will be activated.

1) **Airway Selection dialog:** Filter available airways by selecting East or West, and High or Low. Select EnterWaypoints and Exit Waypoints from pulldown menus, enter enroute MSL Altitude, and click OK. CFPS will insert all intermediate waypoints along route.

   a) You can bypass the dialog window by entering the Airway as you would file it in the fix/point field: “ICT J28 HUV”. Make sure a space exists between data.

2) **MTR Wizard:**

   a) Click Next and Finished to accept Primary routing for entire route.

   b) Select Customize Routing and click Next to Enter/Exit at Alt Entry/Exit points. Select Alt Entry point to pick Starting Point, click Next. Select Alt Exit point to pick Exit Point and click Next. To accept customized routing click Finished. MTR Wizard will enter route turnpoints.

3) **AR Wizard:**

   a) Select track points and AR altitude. Click OK.

   b) Aircraft designated as Tankers in Premission-Config will get the AR Tool instead of the AR Wizard. This allows both tanker and receiver aircraft to enter all AR info in one section. The Wizard only inserts points and altitude.

2. **Search Tools**

   a. Right-click Fix/Point field to open search menus.

   ![Search Menu](image)

   1) **Search Database:** Same as using Search > Database pulldown menu.

      a) Enter Search Text, select database to search, and select Search Type appropriate to type of text entered.
2) **New Point from Radial/DME**: Enter cross-fix from known Navaid. You can also enter directly in Fix/Point field with the Navaid ID followed by radial and DME; i.e. “NKX064007”.

3) **New Point from Existing Point Radial/DME**: Lets you enter a cross-fix off an existing turnpoint.

4) **New Point using “SNAP TO” Closest Point**: Moves current point to the DAFIF point selected from menu. This will change the original coordinates.

3. **Latitude and Longitude**
   
a. Enter **Latitude** and **Longitude** directly into appropriate fields. The lat/long field data will be in **boldface**. These entries will remain unchanged if the route is updated with new DAFIF info. Navaid cross-fix can be generated by right-clicking in **Fix/Point** or **Description** fields and selecting **Calculate Radial/DME Cross Reference**.
   
   **NOTE**: A shortcut is to use “@R”, “@T” to reference off a VORTAC or TACAN. Use “@TCH” to get a reference off the TCH Navaid. “!/A” will **Snap To** the closest airfield (A).

D. **Changing Turnpoint Type**

1. In **Type** field select desired **turnpoint type** from pulldown menu, i.e. DL = Delay, TG = Target, etc. (See **Aviation Type Options** in **Help**)

2. **Tab**, **Enter**, or **clicking** outside turnpoint type box will activate **Point Editor** with the third tab selected for turnpoint types that have additional information associated with them (ex. Delay times and flight modes).

   **NOTE**: Third tab on Point Editor changes with different Turnpoint Types. Associated options on the third tab of Point Editor differ for each Turnpoint Type.

E. **Setting Airspeed, Bank Angle, Altitude, and Flight Mode**

1. Break mission into sections (i.e. IFR to a low-level route, VFR on an MTR, IFR on the RTB). Make changes to first turnpoint in each section and **Replicate** (Ctrl + R) info down to the next section.

   
<table>
<thead>
<tr>
<th>Turn Pt</th>
<th>Type</th>
<th>Fix/Point Description</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Elev</th>
<th>Aspd</th>
<th>Altitude</th>
<th>Wind</th>
<th>Temp</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>IR416C</td>
<td>N 41 36.00</td>
<td>1982F</td>
<td>350C</td>
<td>500A</td>
<td>+10C</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. **Airspeed**: Adjust speed as desired. Speeds can be entered followed by T (True), C (Calibrated), G (Groundspeed), I (Indicated), and M (Mach). No suffix will default to current setting in Sys Admin. Also, not all FPMs can handle Indicated Airspeeds.
3. **Bank Angle**: Adjust bank angle as desired. Enter in degrees (30), G-force (6G), lead turns (30T), or S-turns (15S25). Press F1 in bank field for more options and explanations of banks.

4. **Altitude**: Enter desired altitude in MSL or AGL by following the number with an M or A to override the default. AGL altitudes will only be effective if DTED is loaded for that area or you enter a number in the elevation field.

5. **Flight Mode**: Click FPM button on toolbar, or activate Point Editor and go to FPM tab. Adjust Climb, Cruise, and Descent modes as applicable for the section of the route.

**NOTES**: Flight Performance Modes differ from aircraft to aircraft. The basic 4 Cruise modes are Fixed speed (Standard/Cruise), Best Range, Best Endurance, and Manual.

Some modes will override entered airspeeds after calculation, i.e. MAX RANGE will override entered airspeed and change to calculated max range speed based on altitude, air temperature, etc.

Selecting MANUAL will require entering desired fuel flow by clicking the Inputs button. CHECK THESE NUMBERS! The default for most is 1000 lbs/hr.

a. Adjust **Apply Climb/Descent Mode**… as desired. This option tells the program when to apply climb or descent modes based on altitude change.

6. Replicate changes to subsequent legs by selecting **Replicate Info** from Edit pulldown menu. Use Ctrl+R as a shortcut.

---

### F. Delays & Orbits

1. There are 4 ways to “hold” at a point for a desired amount of time.

   a. **CASC** (CP): Designed for the CAS Tool, but works as a better Delay point. Works just like a Delay, with the exception that it gets depicted as an oval on the map. *This makes your delay easy to identify on the map.*

   b. **Delay** (DL): Choose from Manual (you specify a time) and Auto (calculates time required to meet control times above and below Delay line. Depicted as a circle on map.

   c. **Orbit** (OR): Choose from Manual or Completion Time (assumes a control time above the Orbit line). Put in orbit parameters, length, speed, bank, etc. Depicted as oval prior to calculating and the actual drawn orbit after calculating the route.
d. **Gunship Orbit (GO):** Designed for gunships that orbit around a target but can be used by anyone. Set intercept distance, number of orbits/timing and other parameters. Orbit will be depicted as a circle around the point rather than over it.

G. **Additional Points**

1. Diverts, Offset Aim points, etc. can be set for any point along the route.

   a. With desired turnpoint selected, click **OAP/DVT** on toolbar, or activate Point Editor (Ctrl+B) and select AddPt tab.

   b. Click New button and select appropriate point type from Type pulldown. (DVT for divert)

   c. In Fix field, type in ICAO ID, waypoint name, or right-click to activate search menus.

   d. You can search for a Divert Airfield that meets the requirements you set under Route > Divert Requirements in CFPS by right-clicking in the Fix field and selecting SNAP TO > Airfield.

**NOTE:** Additional Points will not show up on the CFPS route. Details are viewable in Point Editor, and FalconView.

Setting a Divert for the final point on a route will enable DD-175/1801 generator to enter a divert field and an ETE on the DD-175/1801 automatically.

H. **Calculating the Route**
1. Computes headings, times, distances, and fuels based on flight modes selected (airspeeds, altitudes, temperatures, etc.).

2. Click Calculate button on toolbar or select Calculate under Route pulldown menu (also F7).

3. Route Calculations Error/Warning box will appear if errors or warnings are generated in the calculation. Errors must be corrected for route to be printed (must calculate completely).

NOTES: Some errors will allow route to be calculated, but will restrict other functions like DD-175/1801 generator. Ex. FOB/RES errors.

Warnings associated with the statement “route contains points with AGL Altitudes and UNKNOWN elevations” means DTED (Digital Terrain Elevation Data) is not loaded for portions of route where AGL altitudes are entered. CFPS will assume zero elevation and calculate as AGL=MSL unless elevations are entered. Falcon View™ must be running for DTED to be available. Use Turnpoint > Get DTED or Route > Update DTED to populate the elevation values of a specific turnpoint or the entire route.

I. Printing

1. Forms and Kneeboard Cards
   a. To print a form, click Form Selection / Preview button from toolbar, or Form Setup/Preview from File pulldown menu. (F9).
   
   b. Use the default form or Add another.

   c. If the form contains User Mnemonics (user added, non-calculated info), then click the Edit User Mnemonics button. Make the desired changes to the User Mnemonic info and click OK.

   d. Highlight desired form(s) and click the Preview button to view form. Print the form from the preview window.

   e. Using the Print button will print out ALL your aircraft’s default forms. It is recommended that you use the Form Selection / Preview process.

2. Print View
   a. PFPS has the ability to print out the CFPS display as viewed on the monitor. Select Print View or Print View Setup from File pulldown menu.

J. Other Info

1. Timing and Fuel
   a. Highlight the line you wish to onload/offload or set a control time and click the appropriate button.

   b. Fill out information and click OK.

   c. Fuel: Choose from Instantaneous of flow Rate.
1) Receivers have the option to set a **Desired Fuel in Tank** at the end of the onload. This is a great planning tool to pass an amount required to the tankers.

3. **File > Merge Route**
   
a. If your squadron uses any common routing (custom low-level routes, SIDs & STARs, etc.) this feature can save you lots of time.

   b. Create your custom routing and **Save Special** as a **Template** (*.rtt). This will protect the route (read only). When you come to the portion of your mission where you want to attach those points, simply select **File > Merge Route** and select that route segment.

4. **View > Column Profiles**
   
a. Allows you to save the current column setup, or apply an already saved one. Column width is also saved.

   1) Click once on the column header and then click again to allow you to drag it to a new location. Adjust column width as desired.

   2) Use **Hide** and **Show Columns** to display what you want.

   b. **View > Save Profile** allows you to save the current setup.

   c. **View > Default Profile** allows you to apply the current profile as your initial startup one.

5. **Tools (Custom Toolbar)**
   
a. Allows you to add buttons to the CFPS toolbar.

   b. Under Tools, select **Manager**.

   c. Use the **Add** button to create a new button

      Use the **Tool Path** button to browse for the executable file of the program you want to add.